
Document Creator

Document Creator is an add-on for developing report layouts in Microsoft Dynamics 365

Business Central. It makes report layouts easy to edit, saving a lot of time on report

development. By the intuitive report designer and separation of code and layout, also end-users

without technical knowledge can make changes to report layouts.

Document Creator includes an easy-to-use standalone report designer (based on proven

technology, used since 1998, in >50 countries, by >20K users) enhanced with various features

tailored to support natural and efficient report development for Dynamics 365 Business Central.

The report designer is rich in functionality, think of the following features:

Easily add fields and controls via drag & drop,

Generate barcodes from a field/expression, with support for a large number of barcode

types (including, but not limited to, Code39/93/128, EAN-8/13/128, UPC-A/E0/E1 and QR

codes)

Preview changes directly with data from Dynamics 365 Business Central,

Export to various output file formats (including PDF, Word, Excel),

Render HTML embedded in Text-objects,

Use advanced controls, including Scalable Vector Graphics (SVG), Subreports, Shapes,

Charts and Rich Text.

Document Creator includes a Report Translations feature which supports the development of

multilingual reports adding translations as data. Running reports that utilize this feature will

automatically populate the translation table with new records for missing translations. Report

translations can be flexibly edited by end-users on the Document Creator Translations page.

On top of that, Document Creator Export Profiles can be used to fine-tune export settings for

reports with a Document Creator layout. Export reports as interactive PDF forms, change the

quality of images and vector graphics, or specify whether Excel exports of a report should

include the headers and footers.

Watch the video and discover all the benefits of Document Creator in less than 15 minutes.
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Learn more about how to install and use Document Creator:

Installation Manual

User Manual
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Changelog

Extension

1.24.0 (2021-02-01)

The Document Creator Setup now includes a new Fall Back on Default Language setting.

When this setting is enabled, Document Creator will fall back on the translation for the

configured default language code if a translation for a language could not be found. 

The Export Design action now remembers report request page settings.

The Document Creator extension can now also be used in Sandbox Docker containers

without a product key.

The Document Creator app now has a transparent logo.

Fix: Show warning about Translation Update Usage setting only once.

On-Premise Only-Changes

The columns in the dataset (e.g., Date-columns) use the culture that corresponds with the

user's region that is configured in his/her Business Central settings. When a report is

generated we are now passing this data culture along.

The way fields are formatted (e.g., using "," vs. ".") on layouts is determined by the culture of

the server. The Format Locale setting is now also available/visible and used for On-Premise

so this can also be set to a different culture without changing the server's culture settings.
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Fix: "E-mail Product Updates" not sent to the API in Document Creator On-Premise for BC15

and up.

1.20.0 (2020-08-28)

Rebranding to Apportunix

Enable Cloud Printers and (On-Prem) Direct Printing

On-premise demo version: Do not show BC license mismatch warning

1.18.0 (2020-05-28)

Added new Document Creator Export Profile settings:

PDF - New PDF-Compliance option: PDF/A-1a

Word - Print Optimized; Do not expand shift return

Excel - Print Optimized; Split Pages; Font Scale; Print Scaling

1.16.0 (2020-03-23)

Updates to target application 16.0 (Dynamics 365 Business Central 2020 release Wave 1)

Added action "Check License" to Document Creator Setup page for Production environments

On-premise only: License check now also reports mismatch of the active and licensed BC

Serial No.

1.12.0 (2020-02-14)

The demo/trial version is now active in Sandbox environments, also without a product key.

Reports generated from a Sandbox environment will have a DEMO watermark.

A new setting "Format Locale" is available on the Document Creator Setup page. With this

setting you can specify regional settings, such as date and numeric format, that Document

Creator should use.

Show a message to on-premise users to inform about the requirement to install the

additional "Document Creator On-Premise" extension for on-premise usage.
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1.10.0 (2019-12-13)

When a Product Key is entered on the Document Creator Setup page, new-lines and spaces

are stripped from the entered string.

Overriding report actions via a Document Creator Export Profile has been deprecated and

removed.

1.8.0 (2019-11-28)

Initial public release.

Report Engine / Designer

1.23.0 (2021-01-14)

The standalone designer now has the option to start a free (14-day) trial:

1.22.0 (2020-12-11)

The standalone designer now offers the following two commands:

Save As... - Save the design file (.dcrd) to a different location.
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Export Layout As... - Save the layout file, as .dcrx (default) or .frx file, to a different

location.

Cosmetic fix: The open file dialog now shows *.dcrd  as the default file name.

The 'Watermark' class is marked as Serializable to prevent issues when it is used in

codebehind.

1.20.0 (2020-08-28)

Updated base report engine to 2020.3.0

Fixed issue with changing color of object via dropdown

1.19.0 (2020-06-04)

Fixed issue with VisibleExpression not always working due to serialization issue (SaaS)

1.18.0 (2020-05-28)

Updated base report engine to 2020.2.13

Support for new PDF/Word/Excel export-settings
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1.17.0 (2020-02-13)

Added a demo/trial version of the report engine that will produce reports with a DEMO

watermark.

Added option to change the format culture that will be used by the report engine.

Fixed issue with the PrintOnBottom property not working as expected in some cases, e.g., in

combination with RepeatOnEveryPage property.

The standalone designer now properly refreshes datasources, relations and parameters and

also sorts the columns in alphabetical order again.

1.16.0 (2020-01-20)

Fixed an issue with decimals not being parsed correctly when reports were printed under a

region with decimal formatting different from the report engine server.

1.15.0 (2019-11-20)

Initial public release (for BC SaaS).

Templates

1.12.0 (2021-01-20)

Added Warehouse and Assembly Report Templates.

Added Contact Fields on all reports.

Misc. implementation enhancements.

1.10.0 (2020-11-06)

Added Service Report Templates.

Use a global procedure to determine the Date text-formatting that should be used for the

date-columns in the reports.

Resolved warnings from the latest AL compiler.
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1.8.0 (2020-08-28)

Rebranding to Apportunix.

1.6.0 (2020-02-13)

Added a variety of columns and labels to the report objects.

Fixed an issue with the Format-property of the TotalAmountInclVAT TextObject.

Applied the LineHeightAuto property to a majority of the layout TextObjects.

1.4.0 (2019-10-22)

Initial public release.
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Installing the Extension

To install the Document Creator extension for Dynamics 365 Business Central, please follow the

following steps:

Go to Setup & Extensions > Extensions

Open the extension marketplace (AppSource) via: Manage > Extension Marketplace

Search for "Document Creator" (By Apportunix)

Take note of the End-User License Agreement and Privacy Statement

Choose "Free Trial", enter your details, and follow the further steps in the Extension

Installation page

Attention

The installation instructions on this page are for installing Document Creator in a Dynamics 365 Business Central 

online (SaaS/Cloud) environment. If you are looking for installation instructions for Dynamics 365 Business Central

on-premise, then please follow the steps on the page Installing for On-Premise.



1. 

2. 

3. 

4. 

5. 

Important

After the installation, all active users must sign out and sign in again to see the navigation changes from the

Document Creator extension.


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Permission Configuration

Once the Document Creator extension has been installed, a DOCUMENT CREATOR  permission set

will have been added automatically. This permission set (or a customized/derived one) should be

assigned to the relevant users or user groups.

To assign the DOCUMENT CREATOR  permission set to users:

Use the Tell Me search feature ('magnifier-button in the top-right') to search for and open up

the Users page.

Select the user that you want to assign permissions to. Any permission sets that are already

assigned to the user are displayed in the Permission Sets factbox.

Invoke the Edit action to open the User Card page.

On the User Permission Sets FastTab, add a new record with Permission Set set to 

DOCUMENT CREATOR .

For more information on how to configure permissions, please refer to the Dynamics 365

Business Central documentation - Managing Users and Permissions.

1. 

2. 

3. 

4. 
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Setting up your Product Key

Before you can run reports with a Document Creator layout in a Production environment of your

tenant, you will need to configure your product key in the Document Creator Setup page.

You can enter the product key that you received for your tenant in the Product Key field of the 

Authentication group:

Attention

If you do not have a product key for your tenant, then you can use the free Demo/Trial version of Document Creator

in a Sandbox environment. Please find more information on the licensing and pricing on our website.

To order a product key for the full version of Document Creator, please fill in the Order Form on our website.



Note

You can find the Document Creator Setup page under Setup & Extensions > Manual Setup, or you can search for

the page using the Tell Me search feature in Dynamics 365 Business Central.


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Installing for On-Premise

Prerequisites

Before installing Document Creator in your Dynamics 365 Business Central or NAV environment,

please make sure the prerequisites listed in this section are met. Please note that there is a

"Demo" version (for evaluation purposes) and a "Release" version (for production environments)

of Document Creator, which each have their own prerequisites. Downloads for both versions can

be found on the Downloads page on our website.

For additional support, please visit our Support page to get in contact with our support

engineers.

Demo Version

Before installing the "Demo" version, please check if the following prerequisites are met:

The Business Central license should have access to the 70000..70020  and 71000..71010

object ID range.

The latest available Demo product key should be used, which can be downloaded from the 

Downloads page on our website together with the Demo version.

For the use of the Document Creator Report Templates, the Business Central license should

have access to the 72100..72199  (W1) or 72200..72299  (NA) object ID range. However,

please note that the source code of the report templates is also available.

For a demo of all the possibilities of the Document Creator Designer, please check out the 

Document Creator Designer Demo. The Designer Demo can be downloaded from the 

Downloads page on our website as well.

Attention

The installation instructions on this page are for installing Document Creator in an on-premise Dynamics NAV or

Dynamics 365 Business Central environment. If you are looking for installation instructions for Dynamics 365

Business Central online (SaaS/Cloud), then please follow the steps on the page Installing the Extension.



• 

• 

• 

• 

Installation & User Manual Installing for On-Premise

https://apportunix.com/document-creator-downloads/
https://apportunix.com/support/
https://apportunix.com/document-creator-downloads/#u-demo-version
https://apportunix.com/document-creator-downloads/#u-designer-demo


Release Version

Before installing the "Release" version, please check if the following prerequisites are met:

The Business Central/NAV license should have access to the Document Creator object ID

range (i.e., 11249650.. ). If you encounter any issues with missing permissions, please

ensure you have downloaded a new Business Central/NAV license and that you have

restarted your server instance(s) after uploading your license to the database.

A product key registered for your Business Central/NAV license's Serial No./VOICE ID/

PSBCID should be used.

For installation and activation instructions of the Document Creator stand-alone Designer for

Dynamics 365 Business Central, please consult the Installing the Designer documentation

page.

Supported Versions

With the latest Document Creator release the following minimum target versions are officially

supported:

• 

• 

• 

Folder Dynamics NAV/BC Version

NAV80W1 2015: W1 8.00 Build 38457 (Cumulative Update 1)

NAV90W1 2016: W1 9.00 Build 42815

NAV100W1 2017: W1 10.0 Build 13682

NAV110W1 2018: W1 11.0 Build 19394

NAV130W1 BC13: W1 13.0 Build 24623 (Fall '18)

NAV140W1 BC14: W1 14.3 Build 34444 (Spring '19, Cumulative Update 2)

NAV150W1 BC15: W1 15.0 Build 36510 ('19 release Wave 2)

NAV160W1 BC16: W1 16.2 Build 13779 ('20 release Wave 1)
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Installation

This document describes the installation procedure for the following NAV/BC target versions:

Dynamics 365 Business Central 2019 release Wave 2 and up

Dynamics 365 Business Central Spring '19 Release

Dynamics NAV 2015 – 2018 and Dynamics 365 Business Central Fall '18 Release

Dynamics 365 Business Central 2019 release Wave 2 and up

The installation files are grouped into a directory for each target version (e.g., NAV150W1

corresponds to Dynamics 365 Business Central 2019 release Wave 2). Make sure to use the files

from the directory that matches your target. The installation set for each target version contains

the following directories:

The Document Creator app contains all the features available for both On-Premise and SaaS

installations, i.e., creating/editing/importing/exporting/archiving layouts, export profiles, etc.

The Document Creator On-Premise app is an extension on the Document Creator app which

makes the add-on use an on-premise installation of the report engine. It also includes the

features that are only available on-premise, e.g., the RDLC layout converter.

The template report objects are provided with a Document Creator W1 Templates extension.

You can use the source code of the report objects from this extension as a starting point for

your own reports.

Folder Dynamics NAV/BC Version

BC17: W1 17.0 Build 16993 ('20 release Wave 2)

• 

• 

• 

Folder Contents

DOCUMENT CREATOR The Document Creator extension/app.

TEMPLATE Files for template reports, layouts and translations.

• 

• 

• 

Installation & User Manual Installation



To install Document Creator, please follow these steps:

Publishing the "Document Creator" extension

Open the Business Central Administration Shell (as admin) and run the following command

to publish the new extension to your database:

(With $version  being the version of the app you are going to install and $ServerInstance

being the name of the target BC server instance.)

Installing the "Document Creator" extension

If you are not upgrading from a previous version of the extension, see 2.A.

If you are upgrading from a previous version of the extension, see 2.B.

A. Install the extension either through the Install action on the Extension Management page,

or run the following command(s):

B. At this point you will have two versions published to the database. In the Extension

Management page you will see the old version is Installed, while the new version is only

Published/Not installed.

Please, first uninstall the Document Creator On-Premise app.

Run the following commands to sync the app and start the data upgrade:

At this point, you will still have two versions of the extension published, but now the new

version is installed and the old version only published.

Publishing and Installing the "Document Creator On-Premise" extension

1. 

Publish-NAVApp -ServerInstance $ServerInstance -Path "...\DOCUMENT 
CREATOR\Apportunix_Document Creator_$version.app"

2. 

Sync-NAVApp -ServerInstance $ServerInstance -Name "Document Creator"
Install-NAVApp -ServerInstance $ServerInstance -Name "Document Creator"

Sync-NAVApp -ServerInstance $ServerInstance -Name "Document Creator" -Version 
$version
Start-NAVAppDataUpgrade -ServerInstance $ServerInstance -Name "Document 
Creator" -Version $version

3. 
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Please, follow the same instructions from step (1) and (2) to publish and install the 

Document Creator On-Premise app.

Installing the Control Add-In

Open the client, search for, and open the Document Creator Setup page.

In the Document Creator Setup page:

a. Invoke the Install Add-in action.

b. Read and agree with the license agreement and enter your e-mail.

c. You will get a message if the installation has completed successfully.

4. 

Attention

"Allow HTTP Client Requests" should be enabled for the Document Creator On-Premise app for this action to

work. You can change this setting on the Extension Management page via the Configure action.


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Setting up your Product Key

To set up your product key, open the Document Creator Setup page:

a. Paste the product key in the "Product Key" field.

b. Invoke the Check Product Key action to validate the product key.

c. Invoke the License Information action for more information about the license.

Installing the Templates

Please follow the installation instructions on the Templates page.

Document Creator is ready for use!

Dynamics 365 Business Central Spring '19 Release

The installation files can be found in the NAV140W1  directory, which corresponds to the Dynamics

365 Business Central Spring '19 Release. The installation set contains the following directories:

The core features of Document Creator are included in the "Document Creator" extension,

i.e., creating/editing/importing/exporting/archiving/converting layouts, export profiles, etc.

The translation features and report utility functions that can be used in report objects are

provided within a separate "Document Creator Utilities" extension. A C/AL version of the

5. 

Info

If the BC Serial No. of your BC license and the Document Creator product key do not match, then a warning will

be displayed which informs you that the currently active and licensed BC license are not matching. If this

message is shown, you can use Document Creator without any problems, but a watermark will be shown on

generated reports.



6. 

Folder Contents

DOCUMENT CREATOR The Document Creator extension/app.

DOCUMENT CREATOR UTILS The Document Creator Utilities extension/app + C/AL version.

TEMPLATE Files for template reports, layouts and translations.

• 

• 
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objects from this extension are available as well, which you may prefer if you still want to be

able to use these features in C/AL report objects again as well.

The template report objects are provided with a "Document Creator W1 Templates"

extension. You can use the source code of the report objects from this extension as a

starting point for your own reports. A C/AL version of the template report objects are

available as well.

To install Document Creator, please follow these steps:

Publishing the "Document Creator" extension

Open the Business Central Administration Shell (as admin) and run the following command

to publish the new extension to your database:

(With $version  being the version of the app you are going to install and $ServerInstance

being the name of the target BC server instance.)

Installing the "Document Creator" extension

If you are not upgrading from a previous version of the extension, see 2.A. If you are

upgrading from a previous version of the extension, see 2.B.

A. Install the extension either through the Install action on the Extension Management page,

or run the following command(s):

B. At this point you will have two versions published to the database. In the Extension

Management page you will see the old version is Installed, while the new version is only 

Published/Not installed.

Run the following commands to sync the app and start the data upgrade:

• 

1. 

Publish-NAVApp -ServerInstance $ServerInstance -Path "...\DOCUMENT 
CREATOR\Apportunix_Document Creator_$version.app"

2. 

Sync-NAVApp -ServerInstance $ServerInstance -Name "Document Creator"
Install-NAVApp -ServerInstance $ServerInstance -Name "Document Creator"

Sync-NAVApp -ServerInstance $ServerInstance -Name "Document Creator" -Version 
$version
Start-NAVAppDataUpgrade -ServerInstance $ServerInstance -Name "Document 
Creator" -Version $version
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At this point, you will still have two versions of the extension published, but now the new

version is installed and the old version only published.

Publishing and Installing the "Document Creator Utilities" extension

If you want to use translation features and report utility functions from AL only, see 3.A. If

you want to use translation features and report utility functions also from C/AL, see 3.B.

A. Open the Business Central Administration Shell (as admin) and run the following

command to publish the extension to your database:

Then, install the extension either through the Install action on the Extension Management

page, or run the following commands:

If you are upgrading from a previous version of the extension, follow the instructions as

described in the previous step to run the data upgrade in the same way for this extension.

B. Start the Dynamics NAV development environment and import the 

NAV<version>_NewObjects.fob  file.

Import the menu-suite from the NAV<version>_MenuSuite1056.fob  file or edit the menu-

suite object ID in the NAV<version>_MenuSuite1056.txt  file.

Installing the Control Add-In

Open the client, the first time you will get this message:

3. 

Publish-NAVApp -ServerInstance $ServerInstance -Path "...\DOCUMENT 
CREATOR\Apportunix_Document Creator Utilities_$version.app"

Sync-NAVApp -ServerInstance $ServerInstance -Name "Document Creator 
Utilities"
Install-NAVApp -ServerInstance $ServerInstance -Name "Document Creator 
Utilities"

4. 
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Choose "Yes"; Read and agree with the license agreement and enter your e-mail.

You will see a message once the installation has completed successfully.

Setting up your Product Key

To set up your product key, open the Document Creator Setup page:

a. Paste the product key in the "Product Key" field.

b. Invoke the Check Product Key action to validate the product key.

c. Invoke the License Information action for more information about the license.

5. 
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Installing the W1 Template Reports

If you want to use the AL version of the W1 template reports, see 6.A. If you want to use the

C/AL version of the W1 template reports, see 6.B.

A. First publish and then install the extension from the following file:

Then, search for and open the Custom Report Layouts page, choose 'Import Report Package'

and import the following file:

B. Search for and open the Custom Report Layouts page in the Windows client, choose

'Import Report Package' and import the following file:

Then, compile the Document Creator objects (filter on versionlist @*DCR* ).

Importing the Template Translations

Search for and open the Configuration Packages page (RapidStart):

a. Choose Import Package and select the RapidStart package from the TEMPLATE  directory.

b. Select the imported DCR package, choose Apply Package, then confirm. This imports a

set of default translations for the Document Creator layouts.

Document Creator is ready for use!

Dynamics NAV 2015 – 2018 and Dynamics 365 Business Central Fall '18

Release

The installation files are grouped into a directory for each target version (e.g., NAV80W1

corresponds to Dynamics NAV 2015). Make sure to use the files from the directory that matches

your target. The installation set for each target version contains the following directories:

6. 

Apportunix_Document Creator W1 Templates_<version>.app

LayoutPackage - W1 – DCR_<Release/Demo>_<version>.dcr

ReportPackage - W1 – DCR_<Release/Demo>_<version>.dcr

7. 
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To install Document Creator, please follow these steps:

Start the Dynamics NAV development environment and import the NAV<version> - New 

Objects.fob  file.

Merge the following NAV objects with the objects in file NAV<version> - Merge 

Objects.txt :

Import the menu-suite from the NAV<version> - MenuSuite - 1056.fob  file or edit the

menu-suite object ID in the NAV<version> - MenuSuite - 1056.txt  file.

Compile the merged objects.

Open the Windows Client, the first time you will get this message:

Choose "Yes"; Read and agree with the license agreement and enter your e-mail.

Folder Contents

APPLICATION OBJECTS New and Merge NAV Objects.

TEMPLATE Files for template reports, layouts and translations.

1. 

2. 

Type ID Name Applicable for NAV Version

Codeunit 40 LogInManagement NAV2015

Table 9650 Custom Report Layout NAV2015 / NAV2016 / NAV2017 / NAV2018 / BC13

Codeunit 9651 Document Report Mgt. NAV2015 / NAV2016 / NAV2017 / NAV2018

3. 

4. 

5. 
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You will see a message once the installation has completed successfully.

Navigate to (or search for) 'Departments | Document Creator | Document Creator Setup':

a. Paste the product key in the "Product Key" field.

b. Choose Check Product key to validate the "Product Key".

c. Choose License Information for more information about the license.

Navigate to (or search for) 'Departments | Document Creator | Custom Report Layouts':

a. Choose 'Import Report Package...' and select the ReportPackage - 

DCR_Demo_<version>.dcr  file from the TEMPLATE  directory. This imports a default set of

layouts and also the report objects (from the FOB file in the package).

b. Compile Document Creator objects (filter on versionlist @*DCR* ).

Navigate to (or search for) 'Administration | Application Setup | RapidStart Services for

Microsoft Dynamics NAV | Configuration Packages:

a. Choose Import Package and select the RapidStart package from the TEMPLATE  directory.

b. Select the imported 'DCR' package, choose Apply Package, then confirm. This imports the

default translations for the Document Creator layouts.

Document Creator is ready for use!

6. 

7. 

8. 
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Installing the Designer

To edit Document Creator layouts you can use the Document Creator Designer. This is a stand-

alone application that can be installed locally on a Windows PC. Every time the application is

started it will automatically check for and install updates when they are available.

To install the designer:

Invoke the Download Designer action on the Document Creator Setup page.

Download the .application file and wait for the download to complete.

Run the .application file to start the installation, and follow the steps in the installer.

The first time you open the Document Creator Designer the "Document Creator Designer

Activation" form is shown.

1. 

2. 

3. 

Attention

Depending on the configurations on your workstation/PC, you may initially be blocked from installing the

application, e.g., due to restrictions implied by the configuration of the ClickOnce Trust Prompt or Windows

Defender SmartScreen. Please contact your system administrator if you need help to resolve any issues of this

nature.



Important

The Document Creator Designer includes a 14-day unrestricted, free trial. Simply click on the Use Trial button to

start using your free Designer trial period!

To explore the features of the Designer you can also check out the Document Creator Designer Demo.

If you would like to order a product key to activate Document Creator and its designer, please fill in the Order Form

on our website.


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To activate the designer:

Enter the (AAD) Tenant ID or BC License Serial No. of your Business Central tenant in the 

Tenant ID (SaaS) / BC Serial No. (On-Premise) field. The ID for your tenant can be found on

the Document Creator Setup page.

Enter a User Name in the User Name field.

Enter the Product Key for your tenant in the Product Key field.

Click on the Validate button.

1. 

2. 

3. 

4. 

Attention

The Document Creator Designer can only be activated with a product key for licenses in the new license model.

Please see the Pricing page for an overview of the available editions. Please contact us if you require a new product

key for the new license model.



Installation & User Manual Installing the Designer

https://apportunix.com/document-creator-pricing/
https://apportunix.com/contact/


Default Layout

When you create a new Document Creator custom report layout, the Default Layout will be used

as the initial contents of the layout. The standard default layout includes a page header with the

report title, company name, date, page numbering and user ID, and contains a set of styles that

can be applied to controls in the report layout.

The default layout can be changed using the actions in the Document Creator Setup page:

Export Default Layout: Export the layout that is currently in use as the default layout to a 

Document Creator Layout File (.dcrx).

Import Default Layout: Import a new Document Creator layout to use as the default layout

from a Document Creator Layout File (.dcrx).

Init Default Layout: Initialize/reset the default layout to the standard default layout.

• 

• 

• 
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Translation Settings

Document Creator offers its own Report Translations feature, which helps to create multi-

language reports and customizable labels. It ensures that labels can be customized by the end-

user/customer and not just Dynamics 365 Business Central extension developers. That is, the

translations are stored in a table and can be edited in the Document Creator Translations page.

The behaviour of the Document Creator translation feature can be configured in the Document

Creator Setup page through the settings available in the Translations group. The following

settings are currently available to adjust how tags are translated:

Default Translation Language

The Default Translation Language Code field specifies which language will be treated as the

default language. This means that if the default language is set to a language X <> '' , then if a 

Default Translation is provided for a Tag, then this translation will also be used as the translation

for the language with code X .

The Fall Back on Default Language setting can be used to change how to act when a translation

could not be found. When this setting is enabled, Document Creator will fall back on the

translation for the configured default language code if a translation for a language could not be

found.
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Update Usage Method

The Translation Update Usage field specifies whether the Last Used and Last Used by Report ID

fields are updated. The following options can be selected for this setting:

Show Tags

When the Translation Show Tags setting is checked, the Document Creator Translations module

will return tag names (surrounded by angle brackets, e.g., <Amount> ) instead of translations

when they are requested. This can be particularly useful for debugging.

Option Explanation

None The "Last Used" field of translation records is NOT updated.

Last Used Only the "Last Used" field of a translation record is updated when the translation of its tag

is requested.

Last Used & Last

ReportId

Both the "Last Used" and "Last Used by Report ID" field of a translation record is updated

when the translation of its tag is requested.

Caution

Setting the Translation Update Usage field to anything other than "None" may affect performance. By default you

will receive a warning message when a translation is requested and codeunit wDCR_TranslationMgt  still needs to

be initialized, which can be surpressed by enabling the Suppress Update Usage Warnings setting.


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Templates

Document Creator provides a set of templates for reports, layouts and translations which can be

downloaded from the Downloads page on our website.

The Document Creator Templates package includes the following files:

Filename Description

DCR_Translations.rapidstart A RapidStart configuration package with report label translations for the

W1-based report templates for language codes DEU , ENG , ENU , FRA , 

NLD .

Document Creator W1

Templates.Source.zip

A ZIP file containing the source code of the Document Creator W1

Templates extension.

LayoutPackage_W1.dcr A Document Creator Layout Package for the reports in the Document

Creator W1 Templates extension.

Apportunix_Document Creator W1

Templates.app

The Document Creator W1 Templates extension.
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Info

The Document Creator W1 Templates extension includes reports for the following documents:

Sales

Quote

Order Confirmation

Invoice

Credit Memo

Shipment

Return Order

Return Receipt

Draft Invoice

Purchase

Quote

Order

Invoice

Credit Memo

Receipt

Return Order

Return Shipment

Reminder

Service

Quote

Order

Invoice

Credit Memo

Shipment

Pro Forma Invoice (Posted Shipment)

Draft Invoice

Picklist

Contract

Service Item Worksheet

Assembly

Order



• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 
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W1 Templates Installation

To install the W1 Template reports and corresponding layouts, please follow these steps:

On the Home Page, select the Setup & Extensions dropdown

Select Extensions, this will open the Extension Management page.

Invoke the Manage > Upload Extensions action, this will open the Upload and Deploy

Extension page.

Select the Apportunix_Document Creator W1 Templates_<version>.app  file via the

AssistEdit-button of the Select .app file field.

Enable the Accept toggle.

Select Deploy.

Posted Order

Warehouse

Shipment

Posted Shipment

Receipt

Posted Receipt

Pick List

Inventory Pick List

Movement List

Inventory Movement List

Put-Away List

Inventory Put-Away List

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

• 

Info

For on-premise environments, you can use the Admin PowerShell cmdlets to publish the app in case External

Deployment is not enabled.



1. 

2. 

3. 

4. 

5. 

6. 
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Wait for the extension to be deployed. A message should show up to inform you that the

extension deployment is in progress.

Once the deployment has finished, the Document Creator W1 Templates extension will show

up in the Extension Management page. If a previous version was installed, you will see the

previous version has been uninstalled and the new version is now installed.

7. 

8. 
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Use the Tell Me search feature to search for and open up the Custom Report Layouts page.

Invoke the Document Creator > Import Layout Package... action and select the 

LayoutPackage_W1.dcr  file to import the layouts. See Layout Packages.

Select the newly imported layouts and use the Fast Report Layout Selections... action to

configure the layout selections for the reports. See Fast Report Layout Selection Action.

To have the W1 Template reports used when your documents are printed, you need to

configure Report Selections for each document type. You can configure report selections in

the Report Selection - * pages in Dynamics 365 Business Central.

9. 

10. 

11. 

12. 
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Translation Package Installation

To import the template translation package, please follow these steps:

Use the Tell Me search feature to search and open the Configuration Packages page

On the page, invoke the Process > Import Package... action and select the 

DCR_Translations.rapidstart  file.

Wait for the package to be imported.

On the page, invoke the Process > Apply Package action and confirm.

Example

To set up report 72102 Sales - Invoice to be used when a Posted Sales Invoice is printed, search and open the 

Report Selection - Sales page, choose Usage = Invoice and select this report in the Report ID field of the

record.



1. 

2. 

3. 

4. 
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Wait while the package is being applied. You should receive a message that the records are

inserted/modified without errors.

Open the Document Creator Translations page. Here you can verify that the translations

from the package are now indeed added.

5. 

6. 
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Getting Started

In the Dynamics 365 Business Central client use the Tell Me search feature to navigate to the 

Custom Report Layouts page as follows:

The Custom Report Layouts page shows a list of all the custom report layouts in your Dynamics

365 Business Central environment. By default, the page shows the following columns for the

layout records:

Attention

Before you start using Document Creator, please make sure you have completed the steps in the Installation

Manual. The Product Key needs to be set up to run reports with a Document Creator layout.



Column Description

Report ID The ID of the target report object. The report object defines how the report dataset is

generated in code.

Report Name The name of the target report object.

Description A description of the report layout.

Company Name The Dynamics 365 Business Central company that the report layout applies to.

Installation & User Manual Getting Started



From this page you can perform the following tasks for Document Creator layouts:

Creating and Copying Layouts

Editing Layouts using Design Files

Importing and Exporting Layout Packages

Archiving and Restoring Previous Versions of Layouts

Configuring Layout Selections

Creating Support Files

Column Description

Built-In Specifies whether or not the layout is a built-in one, i.e., ships by default with Dynamics

365 Business Central.

Type The type of the report layout which can be either "RDLC", "Word" or "Document Creator".

Document Creator

Export Profile

The Document Creator Export Profile that will be used when the report is run with this

report layout. Only applies to layouts of type "Document Creator". See Export Profiles.

• 

• 

• 

• 

• 

• 
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Creating and Copying Layouts

Creating a New Layout

A Dynamics 365 Business Central report is made up of the following two components:

Report Object: A report object defines the report dataset (i.e., based on the report schema,

which include the dataitems, fields/columns and parameters) and request page. Its

definition is found in the code of a Dynamics 365 Business Central (AL) extension.

Layout: A layout defines how the report dataset should be presented when printed or

exported to a file. You can use a report designer to edit the layout of a report.

To create a new report layout, you first need to have a report object that the layout will target.

You can use one of the report objects from the Microsoft Base Application, use a report object

from our W1 Report Templates extension (see Templates), or from any other extension.

If you have a report object, then you can create a new Document Creator layout for the report on

the Custom Report Layouts page as follows:

Invoke the New... action.

Enter/Select the Report ID of the target report object.

Enable Insert Document Creator Layout.

Select OK.

The figure below shows the inputs on the Insert Built-In Layout page to create a new Document

Creator layout for report 72102 Sales – Invoice:

• 

• 

1. 

2. 

3. 

4. 
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A new record will have been created with "Document Creator Layout" as the default description.

You can change this description to a more descriptive name of your liking.

Copying a Layout

To copy a layout from an existing Document Creator custom report layout record to a new record

on the Custom Report Layouts page, follow these steps:

Select a custom report layout record from which to copy the layout.

Invoke the Copy action

By default the New Layout Description will be set to "Copy of <Original Description>". You can

freely change this description. (Optional)

You can also change the target report object for the new layout if you enable the Change

Dataset option. If this option is enabled, you can enter/select the Report ID of the new target

report object. (Optional)

Select OK.

1. 

2. 

3. 

4. 

5. 
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A new record will have been created containing a copy of the layout of the earlier selected

record.

Caution

If you enable the Change Dataset option and change the target report object, then please take into account that the

schema of the report objects might be different. Therefore, the layout may not work directly, which means you will

need to edit it first to make sure it matches the new schema.


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Editing Layouts

Editing Layouts using Design Files

On the Custom Report Layouts page you will find an Export Design and Import Design action

(within the Document Creator category). These actions can be used to export and import a 

"Document Creator Design File (.dcrd)" for the record selected on the page.

Please note that these actions are only supported for Document Creator layouts. If you attempt

to use these actions for any other layout type, such as RDLC or Word, an error message will be

shown.

Export Design

To start editing a layout, you will need to export the layout in a Design file that you will open in the

Document Creator standalone report designer. If you do not have the designer installed yet, then

please follow the installations instructions at the Installing the Designer page.

To export a layout to edit it in the designer, follow these steps:

Select the Custom Report Layout record.

Invoke the Export Design... action.

The Export Design dialog page opens.

On this dialog page you will find the option Edit with Data (which is enabled by default). If you

enable this option, the Design file will be exported with a dataset, which can be filtered using

the report's request page that will be shown.

1. 

2. 

3. 
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Choose OK.

If you made the choice to Edit with Data earlier, the report's request page will open, where

you can define filters and further options for the dataset to be included in the Design file.

4. 

5. 
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After configuring the options and filters, choose OK and wait for the report to complete.

Save the Design file to a location of your choice.

You can now open the file and use the Document Creator Designer to edit the layout.

6. 
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After you are satisfied with the changes to the layout, you can save and close the designer.

Import Design

When you are done editing the layout in an earlier exported Design file, you need to import the

Design file to apply the changes to the layout in your Dynamics 365 Business Central database.

The Import Design action allows you to select a Design file and import the contained layout into

the record selected on the Custom Report Layouts page.

To import a layout from a Design file, follow these steps:

Select the target custom report layout record.

Invoke the Import Design... action.

Click Choose... and select the Design file in the Open File dialog that appears.

Configuring Layout Selections

To make sure your report uses the correct custom report layout for each company (and does not

use a different layout or print a blank page) you will need to configure the Layout Selections for

your company. One way of doing this is going to the Report Layout Selections page and

configuring the layout selections as described in Change the Current Report Layout.

You can also (more easily) change the layout selections using the Document Creator actions

directly from the Custom Report Layouts page.

Note

In case you enabled the Edit with Data option earlier, you can Preview (Ctrl+P) your layout from the report designer

with the data from your Dynamics 365 Business Central database. In case you disabled the option earlier, the

preview will use a sample dataset with a single record per data source containing the label-/column-names and/or

default values for the columns.



1. 

2. 

3. 

Info

During the import of a Design file, the previous version of the layout is automatically added to the Custom Report

Layout Archive, along with a comment that reads "Design Import". This allows you to restore the previous version of

the layout, e.g., in case you made a mistake and want to revert your changes.


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Report Layout Selection Action

The Report Layout Selection... action can be used to specify per company whether the report

should use the layout selected in the Custom Report Layouts page.

On the Custom Report Layouts page, select the custom report layout record to configure the

report layout selections for.

Invoke the Report Layout Selection... action.

The Report Layout Selection page will open for the selected custom report layout record.

Select the companies where you wish to use the layout when the report is executed. You can

do this by marking the checkbox in the Selected column for those companies.

At the bottom of the page you will see which layout the report is currently using in the

selected company (in group Current Report Layout) and which layout it will use after closing

the page (in group New Report Layout).

Companies that are displayed in bold-green are already using the layout for the report.

Close the page.

The layout selections for the report will be updated after closing the page. If you run the report, it

will now use the layout in the companies you selected.

1. 

2. 

3. 

4. 
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Fast Report Layout Selection Action

The Fast Report Layout Selection... action can be used to specify that the report(s) should use

the layout(s) selected in the Custom Report Layouts page in all companies.

On the Custom Report Layouts page, select the custom report layout records that should be

used for the report layout selections.

Invoke the Fast Report Layout Selection... action.

The action will prompt you to confirm that the layout selection of the corresponding reports

should be changed to the selected custom report layout(s) for all companies.

Example

In the example below a checkmark is set for the company "My Company" which means the report layout selection

for report 72102 Sales - Invoice will change from the built-in RDLC layout to the selected layout (i.e., 72102-000001

DCR Sales - Invoice).

The company "CRONUS NL" is displayed in bold/green which indicates that the report layout selection was already

configured to use this layout earlier.



1. 

2. 

3. 
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If you confirm, then the report layout selections for the reports will be updated to the

selected custom report layout(s) for all companies. A message will inform you about the

number of changed report layout selections.

4. 
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Custom Report Layout Archive

After modifying a Document Creator layout, there is always the possibility to revert your changes

to a previous version of your report layout. On the Custom Report Layouts page you will find an 

Archive factbox that shows the archived versions of the selected layout. Every time a report

layout is changed by an import, an archive version is automatically created.

It is also possible to view all archived custom report layouts by opening the Custom Report

Layout Archive page.
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Archiving Layouts

You can manually archive the current version of a layout using the Archive Layout... action on the

Custom Report Layouts page. A new archive record will be created with the current version of

the selected layout record. By default, the archive commment will be empty, but you can enter

your own comment using the Edit Comment action in the Archive factbox/page.

Note

The Custom Report Layout Archive page can be opened using the Tell Me search feature, or invoking the Navigate >

Document Creator > Archive action on the Custom Report Layouts page.



When are layouts archived automatically?

Custom Report Layouts are archived automatically when the following events take place on the record: Layout

Import, Layout Package Import, Layout Restore, Design Import


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Restoring Layouts

You can restore a previous version of a layout using the Restore Layout action on the Archive

factbox of the Custom Report Layouts page, or the like-named action on the Custom Report

Layout Archive page.

You will be asked to confirm the restore, and the current version will be archived before the

selected previous version is restored.
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Export Profiles

Managing Export Profiles

Reports in Dynamics 365 Business Central can be exported to different file formats, e.g., they

can be exported to a PDF, Word or Excel file. The Document Creator Export Profiles feature can

be used to configure how reports with a Document Creator layout are exported to these file

formats. You can find and manage all export profiles from the Document Creator Export Profiles

page.

Changing Export Profile Settings

Selecting one of the export profiles on this page will open the Document Creator Export Profile

page in which you can view and/or edit the settings for the export profile.
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The available settings are grouped into the following categories.

General Settings

In the General group you will find settings to enter a Code and Description for the export profile.

PDF Export Settings

In the PDF Export Settings group you can change how reports with a Document Creator layout are

exported to PDF. For example, the PDF Compliance of the document can be changed, reports

can be set up to be exported as Interactive Forms, or the quality of images and vector graphics

in the resulting document can be changed in various ways. You can get more information about

the purpose and impact of each of the the available settings from their respective tooltips, or

from the "Export to Adobe Acrobat (PDF)" section in the designer manual.

Word Export Settings

In the Word Export Settings group you can change how reports with a Document Creator layout

are exported to Word. For example, you can change the export method, or use the Wysiwyg

setting to make the output as close to the report layout as possible. You can get more
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information about the purpose and impact of each of the the available settings from the "Export

to Word (RTF)" section in the designer manual.

Excel Export Settings

In the Excel Export Settings group you can change how reports with a Document Creator layout

are exported to Excel. For example, with the Data Only setting you can specify that only the data

and not the headers/footers should be exported, or use the Seamless table setting to enable/

disable the export of page footers and next page headers without table breaks. You can get more

information about the purpose and impact of each of the the available settings from the "Export

to Excel 2007" section in the designer manual.

Using Export Profiles

By default each Document Creator layout will use the Default Export Profile configured in the 

Document Creator Setup page. The default value for this field is DEFAULT , which corresponds to

the automatically generated standard export profile.

You can change which export profile is used by a Document Creator layout by specifying an

export profile code in the Document Creator Export Profile field on the Custom Report Layouts

page.
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Note

If the Document Creator Export Profile field of the layout record is left empty, then the Default Export Profile will be

used when the report is exported with that Document Creator layout in use.



Info

On the very first run of a report with a Document Creator layout, the DEFAULT  export profile will be generated

automatically if it does not exist yet.


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Report Translations

Document Creator includes a Report Translations feature which helps to create multilingual

reports adding translations as data. The report developer can simply add label placeholders in

the report object which automatically populate the Document Creator Translation table. You can

configure the settings of the Report Translations feature in the Translations group of the 

Document Creator Setup page, see Translation Settings.

Benefits:

Translations are no longer in code, but have become data

Non-existing translation records will automatically be created

Translation is no longer restricted to the (AL) extension developer

Translations can be created or modified by the end-user as well

Editing Translations

On the Document Creator Translations page you can view, create and edit translations that can

be used by reports. By default, the page shows the following columns in the main page:

• 

• 

• 

• 

Column Description

Tag The source text/label placeholder to translate.

Default

Translation

The translation for language code '' .

To-do Specifies whether the Tag still needs a Default Translation.

To-do exists Specifies whether there is a translation record with a To-do for any language for the Tag. The

translations of the Tag can be found in the Document Creator Translations subpage.

Report ID If empty, the translations will be used by all reports. If not empty, the translations will be used

as report-specific translations for the report object with the specified ID.
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Column Description

Report Caption The report caption of the report to which the translations apply.

Last Used Specifies when the translation was last used. Whether or not this field is updated depends on

the Update Usage setting.

Last Used by

Report ID

Specifies the ID of the report that last used the translation. Whether or not this field is

updated depends on the Update Usage setting.
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The subpage can be used to enter translations for any language you wish to support.

Info

The Document Creator Translations page also features a Copy... action that can be used to copy translations as

report-specific translations or copy translations for one language code to translations for another language code.


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Adding Translatable Labels to Report Objects

Many document types in Dynamics 365 Business Central have a "Language Code" in the

document header. To translate report labels to the document language and automatically retrieve

the translations and/or populate the Document Creator Translation table with To-do's you can

use the wDCR_TranslationMgt  codeunit in your report object. For an example, please see the

report objects in the W1 Report Templates extension.

First add the following needed global variables:

Add the following code in the OnAfterGetRecord  trigger of the document header dataitem,

which updates the current report language and passes the "Language Code" of the document to

the wDCR_TranslationMgt  codeunit:

Add the following local procedure that can be used to retrieve translations for the report:

Tip

Document Creator ships with a RapidStart package that already provides you with a set of translations for multiple

languages. This package also provides the translations for the W1 Report Templates. See Templates.



Warning

The following section provides details on how an (AL) extension could utilize the Report Translations feature in the

report object definition. Some prior knowledge on extension development is expected.



var
    Language: Codeunit Language;
    wDCR_TranslationMgt: Codeunit wDCR_TranslationMgt;
    ReportId: Integer;

trigger OnAfterGetRecord()
begin
    CurrReport.Language := Language.GetLanguageIdOrDefault("Language Code");
    wDCR_TranslationMgt.wgFncSetLanguageCode("Language Code");
    // ...
end;
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You can then use the Trl  local procedure in the expression of a report column to add a

translatable label to the dataset, e.g.:

local procedure Trl(pLblName: Text[50]): Text
begin
    if ReportId = 0 then begin
        Evaluate(ReportId, DelChr(CurrReport.ObjectId(false), '=', 
DelChr(CurrReport.ObjectId(false), '=', '1234567890')));
        wDCR_TranslationMgt.wgFncSetReportId(ReportId);
    end;
    exit(wDCR_TranslationMgt.wgFncTranslate(pLblName));
end;

column(lblAllowInvDisc; Trl('AllowInvDisc')) { }
column(lblAmount; Trl('Amount')) { }
column(lblBankAccNo; Trl('BankAccNo')) { }
column(lblBankName; Trl('BankName')) { }
// ...
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Layout Packages

A Document Creator Layout Package (.dcr) is a file that contains multiple layouts. Layout

packages can be used to easily export/import multiple layouts from one Dynamics 365 Business

Central database to another. Layouts that are imported from a layout package always add new

layout records, rather than replacing any existing layout records.

You can export and import layout packages from the Custom Report Layouts page. The Export

Layout Package... and Import Layout Package... can be used for this purpose.

Info

If layouts are found that would be overwritten during the import of a Layout Package, then the current version of the

layout is automatically added to the Custom Report Layout Archive before the package is imported, along with a

comment that reads "Layout Package Import".


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Tip

Document Creator ships with a set of W1 Report Templates. This comprises the source code of the report objects

and a layout package. See Templates.


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Support Files

A Document Creator Support File (.dcrz) is a file containing the Document Creator layout, schema

and a dataset for a report. Therefore, a support file can be used to run reports independent from

the Dynamics 365 Business Central database from which the report was originally generated.

Creating Support Files

A support file can be created from the Custom Report Layouts page invoking the Create Support

File... action. This action will open the request page of the report for setting filters and options

for the dataset.

Analyzing Support Files

A support file can be analyzed on the Document Creator Support File Analysis page. You can

upload the support file via the AssistEdit-button of the Support File field. After uploading the

support file and configuring settings on the page, you can use the Run Report action to run the

report with the specified parameters and download the output file for analysis.
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Report Designer Highlights

The Document Creator Report Designer includes the FastReport.Net User's Manual, which can be

opened from the designer via Help > Help Contents. This manual is also available online.

In this section some of the most useful Document Creator Designer features will be highlighted.

These are some of the features that are added on top of the standard FastReport.Net designer to

support even faster and more efficient layout development.

Automatically Generating Totals

For any TextObject on a Data band that contains a numeric field from your dataset, you can

automatically generate a total by right-clicking the TextObject in question, and subsequently

selecting the Create Total... option. This will create a new TextObject under your cursor which

will contain a newly created total.

 

With the new TextObject under your cursor, you can place the TextObject containing the total on

a Footer Band (or any other band of your choosing). You can also edit the total by right-clicking

the newly created TextObject, and selecting the Edit Total... option, which will open the total

editor:

Info

Placing the new TextObject on a Footer-band will automatically set the Reset on band property to the last child band

of the Footer band, to reset the running value back to 0 each time the band is reached.


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For more information on the parameters of a total, see the documentation on Totals.

Transheader and Transfooter Bands

To display transport-totals at the top and/or bottom of a page, you can create Transheader and

TransFooter bands. To create a new Transheader-footer pair, right-click on a Data band, and

select Add / move Band > Trans Header in the appearing context-menu.
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On these bands you can put any earlier-created totals in TextObject controls, whose running

value will be shown on the bottom and top of the pages where needed. In the image below an

example usage of the Transheader and Transfooter band is shown for a Sales Invoice report

layout to show the running value of the total line amount.

Printing Bands on the Page Bottom

To have one or more bands of your report layout shown always at the bottom of the (last) page,

you can use the PrintOnBottom property that is available on bands. For example, if you always

want to show the VAT Specification at the bottom of an invoice, you can right-click the first band
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of the collection of bands to be displayed at the bottom, and select the Print On Bottom option in

the appearing context-menu.

Automatic Text Line Height

In a report layout a TextObject control may contain multiple lines of text. To change the height of

a single line of text in a TextObject, you can use the LineHeight property. The default value of this

property is 0, which means that the line height will be the same as that of the font used. To make

the line height equal to the height of the TextObject you can set the LineHeightAuto property to 

True.

Note

Enabling the PrintOnBottom property for a band will also enable the property for any bands that are displayed

below. Similarly, disabling the property will disable it for any bands that are displayed above.



Caution

The PrintOnBottom property might not work when used in combination with the RepeatOnEveryPage property on a

band. That is, if the band contents do not fit in the remaining free space of the page.


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Switching between Basic and All Properties

In the property grid, you have the option to switch between showing Basic Properties and All

Properties. Selecting the Basic Properties will show you the most common properties and the

properties whose values are different from the default value for the selected object.

You can change the default value of the setting by navigating to View > Options... > User

Interface, which will open the View Options menu. In this menu you can enable or disable the 

"Show all properties in the property-grid by default" setting to change the default filtering of the

property grid.

Info

When you add a new TextObject control to your layout, its LineHeightAuto property is automatically set to true.


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The Basic Properties consist of the following properties:

Basic Properties

Barcode Filter Left RowCount Style

BottomMargin Font LeftMargin RowSpan Text

CanGrow Format LineHeightAuto SegmentCount TextAlign

CanShrink GroupBy MaxHeight SegmentHeight Top

CheckedSymbol Height MaxWidth SegmentWidth TopMargin

ChildDataSource HideIfNoData Name Shape TotalType

ColSpan HideIfUnchecked NoDataText ShowErrorImage VertAlign

ColumnCount HideValue PaperHeight ShowGrid Visible

Condition HideZeros PaperWidth ShowMarkers VisibleExpression

DataColumn HorzAlign ParentDataSource ShowText Width
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View (and Edit) Data

It is possible to view the data that will be used in previews generated from the designer. You can

view the data by selecting one of the Data Sources and then invoking the View Data... option.

In the window that opens you can view the data of each record in the Data Source and even edit

it by leaving a cell after changing its contents.

Basic Properties

DataSource IncludeInvisibleRows PrintOnBottom SizeMode WordWrap

DataType KeepChild RepeatOnEveryPage SortBy WordWrapType

Duplicates KeepTogether ResetAfterPrint SortOrder Wysiwyg

Evaluator KeepWithData ResetPageNumber Spacing

Expression Landscape RightMargin StartNewPage

Info

Any changes you make to the data in the View Data window only changes the data used in the currently opened

designer. Changes you have made to the data from this window in the designer will neither be saved to the Design

file nor to Dynamics 365 Business Central.


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Advanced HTML Rendering

The support for HTML in the TextObject has considerably been extended in the Document

Creator Report Designer. You can enable Advanced HTML rendering by setting the 

TextRenderType property of a TextObject to HtmlAdvanced.

The extended functionalities comprise a larger set of HTML tags being supported, such as

paragraphs, divisions, headers and lists, and support for the most-used CSS style attributes,

which can be embedded in the supported HTML tags.

Supported HTML Tags

The table below presents a complete overview of the tags supported by the advanced renderer:

Tag Description Supported Attributes

<p>...</p> Paragraph with a default bottom-margin of 1 em and top-

margin of 0.

align  – left, right, center,

justify

style  – (see below)
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Tag Description Supported Attributes

<div>...</div> Division/Section without any default margins or

paddings.

align  – left, right, center,

justify

style  – (see below)

<h1>...</h1>

...

<h6>...</h6>

Headings with default font-size of 2 em, 1.5 em, 1.17 em,

1 em, 0.83 em and 0.67 em respectively.

align  – left, right, center,

justify

style  – (see below)

<ol>...</ol> Ordered lists, default bottom margin of 1 em and left-

padding of 40 px.

type  – 1, A, a

start  – [integer]

style  – (see below)

<ul>...</ul> Unordered lists, default bottom margin of 1 em and left-

padding of 40 px.

type  – disc, circle,

square

style  – (see below)

<li>...</li> List item. style  – (see below)

<span>...</span> Span (group of in-line elements). style  – (see below)

<font>...</font> Group of in-line elements with custom font face, color

and size.

color  – [name]/#xxxxxx

face  – [font_family]

size  – [dimension]

style  – (see below)

<br> , <br /> Line break. -

<img> Image. src ="...;base64,..."

alt  – [text]

<body>...</body> Container with default margin of 8 px. style  – (see below)

<b>...</b>

<strong>...</

strong>

Bold text. style  – (see below)

<i>...</i>

<em>...</em>

Cursive text. style  – (see below)
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Other HTML tags will be ignored; the contents will be shown while the surrounding tags are

hidden. The supported tags will be rendered with default margin and padding as defined by the

standards, unless stated otherwise in the table above. If an attribute is specified more than once

in a tag, the last specification will be applied by the renderer.

Supported CSS Style Attributes

The following CSS style attributes are supported by the renderer:

Tag Description Supported Attributes

<u>...</u> Underlined text. style  – (see below)

<s>...</s>

<strike>...</

strike>

Strikeout text. style  – (see below)

<sub>...</sub> Subscript. style  – (see below)

<sup>...</sup> Superscript. style  – (see below)

Attribute Description Supported for Tags

text-

align

Text-alignment of the underlying paragraph. If both the align

and text-align CSS attribute are defined, the CSS attribute has

higher precedence.

p , div , h# , li

text-

indent

Indent of the first line of a paragraph. p , div , h# , li

font-

family

Font face of the underlying text. "all"

font-size Font size of the underlying text. "all"

color Font color of the underlying text, allows one to either specify a

color name or hexadecimal code.

"all"

Installation & User Manual Supported CSS Style Attributes



Example

The following example shows some of the capabilities of the extended HTML renderer.

Attribute Description Supported for Tags

padding

padding-

bottom

padding-

top

padding-

right

padding-

left

Padding of the container or paragraph. p , div , h# , li , ul , ol , 

body

margin

margin-

bottom

margin-

top

margin-

right

margin-

left

Margin of the container or paragraph, treated the same as

padding.

p , div , h# , li , ul , ol , 

body

font-

weight

Font-weight of the underlying text, restricted to the following

options: bold , normal , initial

"all"

<p style="padding-left: 1cm">
  Document Creator is a fully functional .NET report designer for Microsoft 
Dynamics NAV, compatible with <strong>NAV2015</strong> and up.
  It is rich in functionality, e.g., Drag & Drop fields in reports, choose your 
own code per report (VB.NET | C#) and barcode usage, including various <i>QR 
codes</i>.
</p>
<p style="padding-left: 1.5 cm">Your benefits:</p>
<ul style="padding-left: 2 cm">
  <li>Saves a <span style="font-weight: bold">hugh amount</span> of time</li>
  <li>Easy to use</li>
  <li>Rich in functionality<ul type="square">
    <li>An easy-to-use report designer with endless possibilities</li>
    <li>Conversion of <i>Classic</i> and <i>RDLC</i> report layouts</li>
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The above will produce the following output in a TextObject with Advanced HTML rendering

enabled:

    <li>Fully integrated in Dynamics NAV</li>
  </ul></li>
  <li style="padding-top: 6pt"><em>Fantastic reports as outcome!</em></li>
</ul>
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